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Introduction


Having worked for many years with Microsoft’s project management tools, this book is truly a “labor of love” for the two of us. For Dale, this book is his 23rd book on Microsoft Project and the Microsoft PPM solution, while for José, this book is his second.


Welcome to the Ultimate Study Guide for Microsoft Project 2019, a complete learning experience and reference manual for the Microsoft Project 2019 desktop application. Our goal in authoring this book is to teach you how to use the software effectively to manage your projects.


We take a systematic approach to the topical ordering in this book, in which every module teaches you foundational skills by following the project life cycle. In these modules, you learn how to define a new project; plan your project with tasks, resources, and assignments, analyze the Critical Path, baseline your project, enter actual progress, analyze variance, revise your project, report about project progress, and then close the project.


Throughout this book, we provide a generous number of Information, Warning, and Best Practice notes. Information notes call your attention to important additional information about a subject. Warning notes help you avoid the most common problems experienced by others. Best Practice notes provide recommendations for best uses of the tool based on our years of field experience.


With this book, we believe that you can become more effective at using Microsoft Project. If you have questions about the book or are interested in our professional services, please contact us at info@projility.com.


Dale Howard and José Marroig




Downloading the Sample Files


The Hands On Exercises in this book require you to use multiple sample files that accompany this book. Before you attempt to work the first exercise, please download and extract the contents of the Ultimate 2019 Student Files.zip file to a folder of your own choice. You can find the ZIP file at the following URL:


https://www.projility.com/ultimate2019




About Projility


Projility is a Microsoft Project Portfolio Management (PPM), Project Online, Power BI and Dynamics PSA services leader and product innovator. Our consulting services and Hammerhead solutions have helped organizations around the world achieve the following:


•Improved resource utilization


•Increased visibility, insight and control of project, programs, and portfolios


•Reduced cost of deployment and management of PPM systems


•Increased on-time and on-budget projects


•Delivery of true portfolio optimization and strategic execution management capability


The Projility combination of process expertise and implementation capability is unique in the market, providing good practices that have resulted in a 98% on-time, on-budget track record of success for hundreds of Fortune 1000 and Public Sector clients since the firm’s inception in 2005.


Projility’s mantra is “Expert solutions for effective change.” Organizations around the world look to Projility for rapid, comprehensive, and high value Microsoft-based solution implementations, and the unique ability to drive operational change while reducing impact to end users, based upon our implementation methodology and project-based approach.


Our clients come to us for a number of reasons ranging from digital transformations, organization process improvements, end user training, or operational growth. We continue to improve on our services and strive to ensure that our clients are able to achieve their target business outcomes and objectives.




Module 01


Project Management Overview


Learning Objectives


After completing this module, you will be able to:


■Understand the PMI® definition of a project


■Comprehend the project management process as defined by PMI®


Inside Module 01
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Understanding the Project Management Process


Initiating


Planning


Executing


Monitoring and Controlling


Closing




What is a Project?


According to A Guide to the Project Management Body of Knowledge (PMBOK® Guide, 6th Edition © 2017) from the Project Management Institute (“PMI®”), “A project is a temporary endeavor undertaken to create a unique product, service, or result.” According to this definition, a project is:


•Temporary – Every project has a definite beginning and end.


•Unique – Every project is something your organization has not done before, or has not done in this manner.


Understanding the Project Management Process


Because Microsoft Project is a project management tool, you use the software most effectively in the context of the normal project management process. Therefore, it is important to become acquainted with each phase of the project management process and with the activities that take place during each phase. According to the Project Management Institute, the project management process consists of five phases: initiating, planning, executing, monitoring and controlling, and closing.


Initiating


The Initiating phase of a project authorizes the creation of the project and is a part of the project’s scope management process. The Initiating phase of a project usually includes the creation of definition documents that may include one or more of the following:


•The Project Charter is a high-level document that recognizes the existence of the project. This document usually includes the product or service description, the analysis of the business need, and the authority to assign resources to the project. Developed by senior management and stakeholders, the Project Charter feeds the development of the Statement of Work document.


•The Statement of Work (SOW) document defines the project and the product or service produced by the project. Other names for this document are proposal, business plan, Scope of Work, or scoping document. The Statement of Work can include one or more of the following sections:


○Executive Summary


○Phases, Deliverables, and Activities (Tasks)


○Sponsor Responsibilities (Rules of Engagement)


○Assumptions and History


○Acceptance Criteria


○Change Control Policies and Procedures


•A Work Breakdown Structure (WBS) document breaks the project work into meaningful components using summary tasks and subtasks. You use summary tasks to represent the Phases and Deliverables in the project, and you use subtasks to show the activities team members must perform to complete a Phase or Deliverable section in the project. You see the Work Breakdown Structure of summary tasks and subtasks in Microsoft Project on the left side of any task view, such as the Gantt Chart view.


Information: Projility recommends that you carefully define your project and do not stop the Initiation process until you fully understand your project requirements. In a famous Dilbert™ cartoon, the pointy-haired boss asks Dilbert to start a project to create a new product for a customer. When Dilbert complains that he does not know the customer’s product requirements, the pointy-haired boss replies, “Well, start working on the project and we’ll come up with the requirements later.”


Planning


The Planning phase of a project typically occurs when the project manager becomes directly involved with the project. This phase is of major importance to the potential success of any project. According to the PMBOK® Guide, the Planning phase can include any of the following processes:


•Scope Planning and Definition


•Activity Definition


•Activity Sequencing


•Activity Duration and Work Estimating


•Resource Planning


•Schedule Development


•Cost Planning and Budgeting


•Risk Management Planning


•Project Plan Development


Best Practice: Projility strongly recommends that you perform risk management planning in every project. In the real world, things go wrong, and you must plan accordingly.


Executing


The Executing phase of a project is the process of moving forward with the project by your project team members performing the activities (tasks) associated with the project. This phase also involves coordinating the resources to carry out the project plan. The Executing stage should include the following processes:


•Saving a Project Baseline – Prior to beginning work on the project, you must save a baseline for your project. You use the baseline to compare project progress with your original project estimates and then to analyze project variance. You should save the project baseline at the beginning of the project, and you should never change the original project baseline without good reason and without stakeholder agreement.


•Tracking Project Progress – Collecting actual project data is critical to controlling the project. Ideally, you should gather and update actual progress from your project team on a weekly basis, or at any other frequency tuned to your organization’s project lifecycle.


•Analyzing Project Variance – Throughout the life of the project, you must analyze project variance between the current project schedule and the original baseline schedule, and identify trouble spots in the project.


•Revising the Project Plan – Based on the results of variance analysis, you may need to revise the project to stay within its predefined scope, schedule, and budget.


•Reporting Project Progress –Throughout the life of the project, you should seek to identify the reporting needs of all project participants, and then create custom views and reports in Microsoft Project to meet these needs.


Monitoring and Controlling


During the Monitoring and Controlling phase of the project, various interested parties may request changes to the project. These interested parties may include your customer, your project stakeholders, your project executives, your fellow project managers, and even your project team members. In the face of relentless change requests, you must maintain control over the project to ensure that your project meets its objectives. Some common aspects of project control include the following:


•Change Control – Change control is the process of managing changes to the predefined scope of the project.


•Continued Communication – A critical component of controlling any project is communication. You must keep communication lines open at all times with all project participants.


Best Practice: Projility recommends that your organization define a formal change control process to manage project changes. Every project change can potentially increase the project cost and delay the project finish date. Without a change control process in place, you may not be able to reject changes that are not beneficial to the project’s goals and objectives, needlessly driving up your project costs and delaying the completion of your project!


Closing


The Closing phase of the project formalizes the acceptance of the project and then closes the project. At the conclusion of project closure, you release your resources from the project team to work on other projects. The Closing phase can include any of the following:


•Project Closure Methodologies are the processes through which you formally close your project. They must clearly define the “exit criteria” which are critical to measuring the success of your project.


•A Lessons Learned meeting (aka “post mortem” meeting) is a wise practice to evaluate the successes and failures during the project life cycle. From this meeting, you should document the lessons learned and then use this information when you plan future projects. The goal of every ”lessons learned” meeting is to determine “how we can do better the next time.”


•Use a Template Creation process to create project templates from successful projects for similar project types. It is part of your job as a project manager to define project types, build templates to meet other project needs, and modify templates to meet the unique needs of each project.


Once you understand the project management process, you are ready to begin learning how to use Microsoft Project. In the remainder of this book, I show you how to harness the power of the software by using best practices during each stage of the project management life cycle. During the Initiating stage, I show you how to define a new project using a six-step process. During the Planning stage, I show you how to conduct the task planning, resource planning, and assignment planning processes. During the Executing stage, I show you how to view the Critical Path, baseline your project, enter task progress, perform variance analysis, and revise your project. During the Monitoring and Controlling stage, I demonstrate how to handle change control issues and to report on your project. Finally, during the Closing stage, I show you how to save a completed project as a template and how to use the Compare Projects utility to compare a completed project with the initial planned project.




Module 02


Microsoft Project Overview


Learning Objectives


After completing this module, you will be able to:


■Understand and use the Start page


■Understand the purpose of the Global.mpt file in Microsoft Project


■Name the objects shown in the Microsoft Project user interface


■Understand the features of the Ribbon


■Customize the Ribbon and the Quick Access Toolbar


■Access and use the Backstage


■Use navigation tricks to better navigate the Microsoft Project environment


■Understand the symbols used in the Gantt Chart view


■Read and understand a Gantt Chart


■Create and use a three-tiered timescale


Inside Module 02


Understanding and Using the Start Page
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Using the Task Ribbon


Using the Resource Ribbon


Using the Report Ribbon


Using the Project Ribbon


Using the View Ribbon


Using the Format Ribbon


Collapsing the Ribbon


Customizing the User Interface


Customizing the Ribbon


Customizing the Quick Access Toolbar


Importing/Exporting a Custom Ribbon and Quick Access Toolbar


Accessing and Using the Backstage


Using the Info Page


Using the New Page


Accessing Templates Stored in Your Templates Folder


Using the Save As Page


Saving a Project to your Computer


Saving a Project to a OneDrive Folder


Saving a Project to SharePoint Documents Library


Synchronizing with a SharePoint Tasks List


Using the Open Page


Using the Print Page


Using the Share Page


Using the Export Page


Using the Account Page


Using the Options Button


Closing a Project File


Navigating in Microsoft Project


Navigating to the Beginning of the Project


Using the Scroll Bars


Using Shortcut Menus


Using Built-In Keyboard Shortcuts


Zooming the Timescale


Using the Scroll to Task Button


Using Screen Tips and Tool Tips


Understanding the Planning Wizard


Understanding Gantt Chart Symbols


Reading a Gantt Chart


Creating a Three-Tiered Timescale


Displaying Fiscal Year in a Three-Tiered Timescale




Understanding and Using the Start Page


Each time you launch a newly-installed copy of Microsoft Project, the software displays the Start page in the Backstage, such as shown in Figure 2 - 1. Notice that this page contains a list of templates at the top of the page and a list of recently opened files in the Recent section of the page. At the top of the page, the template buttons offer you multiple methods for creating a new project.




[image: image]


Figure 2 - 1: Start page





In the Recent section of the page, notice that Microsoft Project displays the name of each recently opened project, along with the file path to the project file. To find an existing project not currently shown in the Recent section of the page, scroll to the bottom of the page and click the More projects [image: image] link. To open a recent project, simply click the name of the project. Microsoft Project opens the project in Read/Write mode, ready for you to work with the project.


To pin one of the recently used projects so that it always shows at the top of the Recent section of the page, right-click on the project name and select the Pin to list item on the shortcut menu. The software moves the pinned project to the top of the Recent list, displays a “pushpin” indicator to the right of the project name, and then additionally displays the pinned project in the Pinned section of the page. To unpin one of the pinned projects at the top of the Recent or Pinned sections of the page, right-click on the project name and select the Unpin from list item on the shortcut menu. To remove one of the recently used projects anywhere in the Recent section of the page, right-click on the project name and select the Remove from list item on the shortcut menu.


Warning: When you right-click on any project shown in the Recent list or Pinned list, the shortcut menu includes an option named Delete file. Some people erroneously select this option on the shortcut menu, thinking that this removes the project from the list. Rather, if you select the Delete file option, Microsoft Project deletes the file from its current file location. To prevent a potential deletion disaster in which you accidentally delete a file for which you have no backup, Microsoft Project displays a confirmation dialog in which you must confirm the deletion.


To create a new project, click one of the template buttons at the top of the page. You can also click the More Templates [image: image] link to view the New page in the Backstage, which displays additional templates for Microsoft Project. When viewing additional templates on the New page, you can also click the Show More link to view all templates available for Microsoft Project.


On the New page, you can also search for a project template in the Office.com website using one of the following methods:


•Enter your search term in the Search for online templates field in the middle of the page and then click the Start searching button (the magnifying glass button) at the right end of the field.


•Click one of the template categories listed immediately below the Search for online templates field.


During the search process, Microsoft Project briefly displays a Searching thousands of online templates message, and then reveals the search results on the New page. Notice in Figure 2 - 2 that using the search term server yielded two templates related to Project Server 2013.




[image: image]


Figure 2 - 2: Search for an online template





To return to the Start page, click the Home button in the upper left corner of the page. To exit the Start page and navigate directly to the main user interface of Microsoft Project, press the Escape key on your computer keyboard.


Information: To stop Microsoft Project from displaying the Start page each time you launch the software, click the Options button in the lower left corner of the Start page. On the General page of the Project Options dialog, deselect the Show the start screen when this application starts checkbox and then click the OK button. Exit Microsoft Project and then relaunch the software to create a new blank project and display the normal user interface.


Hands On Exercise


Exercise 2 - 1


Explore the Start page in Microsoft Project.


1.Launch Microsoft Project and examine the Start page in the Backstage.


Notice the template buttons at the top of the Start page and any recently opened projects in the Recent section of the page.


2.In the upper right corner of the page, click the More Templates [image: image] link to view the New page in the Backstage.


3.In the Search for online templates field in the middle of the page, enter construction in the field, and then click the Start searching icon (the magnifying glass icon).


Notice that Microsoft Project displays two construction-related project templates.


4.Click the [image: image] Back button to return to the New page in the Backstage.


5.Immediately below the Search for online templates field in the middle of the page, click the Business link to display business-related project templates.


Notice that the software displays a large number of business-related project templates.


6.In the upper left corner of the New page, click the Home button to return to the Start page.


7.If you see any projects listed in the Recent section of the Start page, right-click on a project and select the Pin to list item on the shortcut menu.


Notice that Microsoft Project pins the project at the top of the Recent list and displays the “pushpin” indicator to the right of the project name.


8.Right-click on the same project and select the Unpin from list item on the shortcut menu.


Warning: If you complete the following steps in this exercise, you will stop Microsoft Project from displaying the Start page every time you launch the software. If you do not want to see the Start page every time you launch the software, then complete the following steps. However, if you want to continue seeing the Start page every time you launch the software, then click the Open button in the Backstage and skip ahead to step #14 below.


9.Click the Options button in the lower left corner of the Start page to display the Project Options dialog.


10.In the Start up options section of the General page of the dialog, deselect the Show the Start screen when this application starts option, and then click the OK button.


11.Click the Close button (the X button ) in the upper right corner of the Microsoft Project application window to exit the software.


12.Launch Microsoft Project again.


Notice that Microsoft Project no longer displays the Start page when you launch the software.


13.Click the File tab and then click the Open button on the left side of the Backstage.


14.On the Open page of the Backstage, click the Browse button.


15.In the Open dialog, navigate to the folder where you unzipped the sample files that accompany this book.


16.In the Open dialog, select the Project Navigation 2019.mpp sample file, and then click the Open button.


Warning: As you work the Hands On Exercises in this book, whenever you open a sample file that displays the Gantt Chart view initially, I strongly recommend that you immediately drag the split bar to the right edge of the Duration column. This is a necessary and important step that will make it easier for you to complete the steps in each Hands On Exercise.


17.Leave the Project Navigation 2019.mpp sample file open for the next exercise.


Understanding the Global.mpt File


Microsoft Project uses the Global.mpt file as the template from which to create all new blank project files. When you launch the software, Microsoft Project opens the Global.mpt file from your hard drive and loads it into the background memory. This file is like a “library” that contains all of the default objects that ship with the software, including default views, tables, filters, groups, reports, calendars, etc. You can also use the Global.mpt file to store any custom personal objects you create, such as custom views, tables, filters, and groups. Storing your custom personal objects in the Global.mpt file makes them available to all current and future projects.


Although you cannot view the Global.mpt file directly, you can view it indirectly. Make sure that you have a least one project open, then click the File tab and then click the Info tab in the Backstage. In the Organize Global Template section of the Info page, click the Organizer button. Microsoft Project displays the Organizer dialog shown in Figure 2 - 3. The list on the left side of the dialog shows the default and custom objects stored in the Global.mpt file.
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Figure 2 - 3: Organizer dialog shows the Global.mpt file





Click the Cancel button to close the Organizer dialog and then press the Escape key on your computer keyboard to exit the Backstage. Alternately, you can click the Back button (large [image: image] button) in the upper left corner of the Backstage.


Warning: You must have at least one project open in Microsoft Project before you can access the Organizer dialog.


Hands On Exercise


Exercise 2 - 2


Examine the Global.mpt file in Microsoft Project.


1.Return to the Project Navigation 2019.mpp sample file, if necessary.


2.Click the File tab and then click the Info tab in the Backstage.


3.On the Info page of the Backstage, click the Organizer button.


In the lower left corner of the Organizer dialog, notice that the software selects the Global.MPT item on the Views available in pick list by default.


4.Individually click each of the tabs at the top of the Organizer dialog to see all of the default objects included in the Global.mpt file, including the default views, tables, filters, groups, reports, etc.


5.Click the Cancel button to close the Organizer dialog.


6.Press the Escape key on your computer keyboard to exit the Backstage.


7.Leave the Project Navigation 2019.mpp sample file open for the next exercise.


Understanding the User Interface


Figure 2 - 4 displays the Microsoft Project user interface with the main features labeled.
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Figure 2 - 4: Microsoft Project user interface





You use these user interface features as follows:


•Use the Ribbon to access commands and buttons.


•Customize and use the Quick Access Toolbar to display frequently used commands and buttons.


•Use the File tab to access all file-related features, such as open, save, or print in the Backstage.


•Use the Timeline pane to create a timeline report about the current task schedule of your project.


•Use the Select All button to select all items in the current view. You can also right-click on the Select All button and use the shortcut menu to select a different table.


•Use the Timescale bar to determine the current level of zoom applied to your project.


•Use the Task Sheet pane to list tasks or activities in your project.


•Use the Gantt Chart pane to view a visual schedule for every task in your project.


•Use the Default Task Mode selector to specify the default Task Mode setting for all new tasks you add to the project.


•Use the Zoom slider to quickly zoom the Timescale bar.


•Use the Quick View selector to apply four commonly used views and to access the most recent report.


Understanding the Ribbon


Use the Ribbon to access commands and buttons in Microsoft Project. By default, the software includes six ribbons, including the Task, Resource, Report, Project, View, and Format ribbons. To display any ribbon, click the relevant tab at the top of the Ribbon. For example, click the Task tab to display the Task ribbon.


Using the Task Ribbon


Microsoft Project displays the Task ribbon by default when you access the main user interface. The Task ribbon contains all of the commands and buttons you need for task planning. Figure 2 - 5 shows the Task ribbon.
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Figure 2 - 5: Task ribbon





The software organizes the commands and buttons on the Task ribbon into eight sections, which include the View, Clipboard, Font, Schedule, Tasks, Insert, Properties, and Editing sections. The View section of the Task ribbon contains a single button, the Gantt Chart pick list button. If you click the top half of this split button, Microsoft Project displays the most recent view containing a Gantt Chart on the right side of the view. If you click the bottom half of the button (the pick list arrow), the software displays a list of the most commonly used task and resource views, including any custom views you create.


The Font section offers you a complete set of buttons used to format the font and the cell background color of any task. This section also includes the Font Dialog Launcher button, circled in the image shown in Figure 2 - 6.
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Figure 2 - 6: Font Dialog Launcher button





When you click the Font Dialog Launcher button, Microsoft Project displays the Font dialog shown in Figure 2 - 7. This dialog includes all of the available commands for font formatting and cell background color formatting.
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Figure 2 - 7: Font dialog





Using the Resource Ribbon


Click the Resource tab to display the Resource ribbon shown in Figure 2 - 8. The software divides the Resource ribbon into five sections, which include the View, Assignments, Insert, Properties, and Level sections. The View section of the Resource ribbon contains a single button, the Team Planner pick list button. If you click the top half of this split button, Microsoft Project displays the Team Planner view. If you click the bottom half of the button (the pick list arrow), the software displays a list of the most commonly used task and resource views, including any custom views you create.
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Figure 2 - 8: Resource ribbon





Warning: The Professional version of Microsoft Project displays the Team Planner pick list button in the View section of the Resource ribbon. If you have the Standard version of the software, the View section displays the Resource Sheet pick list button instead. If you click the top half of this split button, the software displays the Resource Sheet view.


Use the Resource ribbon while displaying any resource view (such as the Resource Sheet view) to manage the re-sources in your project. The exceptions to this statement are the Assign Resources button, which you can use with any task view (such as the Gantt Chart view) to assign resources to tasks, and the buttons in the Level section, which you can use with either a task view or a resource view applied.


Using the Report Ribbon


Click the Report tab to display the Report ribbon shown in Figure 2 - 9. The software divides the Report ribbon into three sections, which include the Project, View Reports, and Export sections. Use the Report ribbon to work with the Compare Projects wizard, to work with Dashboard Reports, and to work with Visual Reports.
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Figure 2 - 9: Report ribbon





Using the Project Ribbon


Click the Project tab to display the Project ribbon shown in Figure 2 - 10. The software divides the Project ribbon into six sections, including the Insert, Add-Ins, Properties, Schedule, Status, and Proofing sections. Use the Project ribbon to work with high-level information about your project.
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Figure 2 - 10: Project ribbon





Using the View Ribbon


Click the View tab to display the View ribbon shown in Figure 2 - 11. The software divides the View ribbon into seven sections, including the Task Views, Resource Views, Data, Zoom, Split View, Window, and Macros sections. The Task Views section includes five pick list buttons that allow you to display commonly used task views, such as the Task Usage view. The Resource Views section contains four pick list buttons that allow you to display commonly used resource views, such as the Resource Sheet view.
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Figure 2 - 11: View ribbon





Use the View ribbon to apply default and custom views, tables, filters, and groups to your project. For example, you can use the Timeline and Details checkboxes in the Split View section of the View ribbon to display the Timeline pane above the Gantt Chart pane, or to display the Task Form pane below the Gantt Chart pane.


Using the Format Ribbon


Use the Format ribbon to customize the display of any view. Apply the view you want to format (such as the Gantt Chart view), and then click the Format tab to display the Format ribbon. Microsoft Project displays the context-sensitive Format ribbon with commands and buttons that apply to the current view. Figure 2 - 12 shows the Format ribbon for the Gantt Chart view. Notice in Figure 2 - 12 that the software indicates that I can format the Gantt Chart view by displaying the Gantt Chart Tools header immediately above the Format tab.
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Figure 2 - 12: Format ribbon for the Gantt Chart view





The software divides the Format ribbon into sections relevant to the type of view currently displayed. For example, the Format ribbon for the Gantt Chart view contains six sections, including the Format, Columns, Bar Styles, Gantt Chart Style, Show/Hide, and Drawings sections.


Always keep in mind that the Format ribbon displays the appropriate formatting options for the current view. This means that the commands and buttons on the Format ribbon can vary dramatically, depending on the formatting options available for the current view. For instance, Figure 2 - 13 shows the Format ribbon for the Task Usage view. Notice the set of options available in the Details section of the Format ribbon.
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Figure 2 - 13: Format ribbon for the Task Usage view





Figure 2 - 14 shows the Format ribbon for the Team Planner view. Notice that the Format ribbon for this view includes a number of buttons and commands not available when formatting other views.
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Figure 2 - 14: Format ribbon for the Team Planner view





Warning: Remember that if you use the Standard version of Microsoft Project, the software does not include the Team Planner view. This view is only available in the Professional version of the software.


Figure 2 - 15 shows the Format ribbon for the Calendar view. Notice that the Format ribbon offers very few options for formatting the Calendar view.
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Figure 2 - 15: Format ribbon for the Calendar view





Information: I do not document the commands and buttons available on the Format ribbon for every view in Microsoft Project. Keep in mind that each view includes a unique set of options for formatting the view, plus one or more options in common with other views of that type.


Collapsing the Ribbon


Microsoft Project allows you to collapse the Ribbon to see more information in the current view. The software offers you three different methods to collapse and expand the Ribbon. These methods include:


•Double-click any ribbon tab.


•Right-click any ribbon tab and either select or deselect the Collapse the Ribbon item on the shortcut menu.


•At the right end of the Ribbon, click the Collapse the Ribbon [image: image] button to collapse the Ribbon. Click any ribbon tab to expand the collapsed ribbon, then click the Pin the ribbon [image: image] button at the right end of the Ribbon.


Information: If you like to use keyboard shortcuts, you can also collapse and expand the Ribbon by pressing the Control + F1 keyboard shortcut on your computer keyboard.


Hands On Exercise


Exercise 2 - 3


Study the Ribbon in Microsoft Project.


1.Return to the Project Navigation 2019.mpp sample file, if necessary.


2.Click the Task tab to display the Task ribbon, if necessary.


3.Examine the buttons in each section of the Task ribbon.


4.In the lower right corner of the Font section of the Task ribbon, click the Font Dialog Launcher button.


5.Examine the options in the Font dialog and then click the Cancel button to close the dialog.


6.Individually click the Resource, Report, Project, View, and Format tabs and study the sections and buttons in each of these ribbons.


7.Click the Task tab to display the Task ribbon.


8.In the View section of the Task ribbon, click the Gantt Chart pick list button and select the Resource Usage view.


9.Click the Format tab to display the Format ribbon with the Resource Usage Tools applied.


10.Examine the buttons in each section of the Format ribbon.


11.Double-click the Format tab to collapse the Ribbon.


12.Click the Task tab to expand the Ribbon temporarily.


13.Right-click the Task tab and then deselect the Collapse the Ribbon item on the shortcut menu.


14.In the View section of the Task ribbon, click the Gantt Chart pick list button and select the Gantt Chart view.


15.Leave the Project Navigation 2019.mpp sample file open for the next exercise.


Customizing the User Interface


Microsoft Project offers you two ways to customize the user interface by modifying the Ribbon and the Quick Access Toolbar. I discuss each of these topics separately.


Customizing the Ribbon


You can customize the Ribbon by adding custom ribbon tabs, custom ribbon groups, and buttons. To begin the process of customizing the Ribbon, complete the following steps:


1.Click the File tab and then click the Options button in the lower left corner of the Backstage.


2.In the Project Options dialog, click the Customize Ribbon tab.


Figure 2 - 16 displays the Project Options dialog with the Customize Ribbon page displayed. Notice that the Customize Ribbon page of the dialog contains two sections. Use the Choose commands from section on the left side of the dialog to select the commands you want to add to the Ribbon. Use the Customize the Ribbon section on the right side of the dialog to select the ribbon tab you want to customize.
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Figure 2 - 16: Project Options dialog, Customize Ribbon page





Information: You can also display the Customize Ribbon page of the Project Options dialog by right-clicking on any ribbon tab, such as the Task tab, and then clicking the Customize the Ribbon item on the shortcut menu.


3.Click the Choose commands from pick list and choose the type of commands you want to add to the Ribbon. The pick list offers you the following choices: Popular Commands (the default setting), Commands Not in the Ribbon, All Commands, Macros, File Tab, All Tabs, Main Tabs, Tool Tabs, and Custom Tabs and Groups.


4.Click the Customize the Ribbon pick list and select which ribbon tabs to display in the dialog. You have three choices: Main Tabs (the default setting), Tool Tabs (used for formatting views), and All Tabs (offers both the Main Tabs and the Tool Tabs).


After you select your options on the Choose commands from pick list and the Customize the Ribbon pick list, you are ready to customize the Ribbon. The software offers you multiple choices for customizing the Ribbon:


•Display or hide a ribbon tab.


•Create a new ribbon tab.


•Create a ribbon group in a new or existing ribbon tab.


•Add or remove buttons on a default or custom ribbon tab.


•Rename a ribbon tab, a ribbon group, or a button.


•Move buttons, ribbon groups, and ribbon tabs.


•Reset the entire ribbon to its default settings.


•Import or export the customized Ribbon and Quick Access Toolbar settings to a file.


Displaying/Hiding a Ribbon


To display or hide any ribbon tab, select or deselect the checkbox to the left of the ribbon tab in the Customize the Ribbon page of the Project Options dialog. For example, if you are a software developer, you might want to display and use the Developer ribbon so that you can create macros in the Office VBA programming language for Microsoft Project. To display the Developer ribbon, select the option checkbox for the Developer tab, and then click the OK button. Figure 2 - 17 shows the Developer ribbon after selecting the option to display it in the Project Options dialog.
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Figure 2 - 17: Developer ribbon





To hide any ribbon tab currently displayed, deselect the option checkbox for the ribbon tab in the Project Options dialog and then click the OK button.


Creating a New Ribbon Tab or Ribbon Group


To create a new ribbon tab, select an existing ribbon tab in the Customize the Ribbon list in the location where you want to insert the new ribbon tab, and then click the New Tab button. The software inserts a new ribbon tab named New Tab below the selected ribbon tab. Figure 2 - 18 shows a new ribbon tab added below the View ribbon. Notice that the new ribbon tab also includes a custom ribbon group named New Group. Every default and custom ribbon tab must contain at least one ribbon group, but you can also create additional ribbon groups.


Microsoft Project allows you to organize the Ribbon commands and buttons into groups, with a label displayed at the bottom of each group. You can add a custom ribbon group to any default or custom ribbon tab. To create a new custom ribbon group, select an existing ribbon tab or ribbon group, and then click the New Group button. The software adds the new custom ribbon group below the selected ribbon tab or ribbon group. You should create a custom ribbon group for every section of buttons you want to display on your custom ribbon tab.
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Figure 2 - 18: Customize the Ribbon list - new ribbon tab added





Information: To remove a custom ribbon group or ribbon tab, select the item in the Customize the Ribbon list and then click the Remove button. Be careful about removing any ribbon group on one of the default ribbon tabs, however, as the only way to restore it is to reset the entire ribbon back to its default settings using the Reset button.


Renaming a Ribbon Tab or Ribbon Group


After creating a new ribbon tab or ribbon group, you should immediately rename it. To rename a ribbon tab, select the name of the ribbon tab and then click the Rename button. Microsoft Project displays the Rename dialog shown in Figure 2 - 19. Enter the name of the new ribbon tab in the Display name field and then click the OK button.
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Figure 2 - 19: Rename dialog for a new custom ribbon tab





To rename a ribbon group, select the name of the ribbon group and then click the Rename button. Microsoft Project displays the Rename dialog shown in Figure 2 - 20. Enter the name of the new ribbon group in the Display name field and then click the OK button.
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Figure 2 - 20: Rename dialog for a new custom ribbon group





Information: When you use the Rename dialog to rename a ribbon group, selecting a symbol in the Symbol list does not affect the ribbon group at all. Selecting a symbol in the Symbol list only applies to renaming buttons that you add to a custom ribbon group.


Adding, Removing, and Renaming Buttons on a Ribbon Tab


After creating a new custom ribbon tab and adding one or more custom ribbon groups, you are ready to add buttons to your new custom ribbon tab. Before you add a button, be sure to click the Choose commands from pick list in the upper left side of the dialog and to select an option that displays the type of commands you want to add. For example, I normally select the All Commands item on the pick list to make sure I can see every available command. If you want to add buttons for any macros you record or write, select the Macros item on the Choose commands from pick list instead.


To add a button to a ribbon tab, select the button in the Choose commands from list on the left side of the dialog, select the ribbon group in the Customize the Ribbon list on the right side of the dialog, and then click the Add >> button. Microsoft Project adds the button to the selected ribbon group.


To rename a button, if necessary, click the name of the button and then click the Rename button. Microsoft Project displays the Rename dialog shown previously in Figure 2 - 20. Enter the new name of the button in the Display name field, select a symbol for the button in the Symbol list, and then click the OK button.


Warning: You cannot add a button to any default ribbon tab unless you create a custom ribbon group on that Ribbon. This means that you cannot add buttons to a default ribbon group on any default ribbon.


To remove a button on any ribbon tab, select the button in the Customize the Ribbon list and then click the Remove button. Remember that you can also remove a custom ribbon tab or custom ribbon group using the same process.


Moving Items in the Ribbon


Microsoft Project allows you to move default and custom ribbon tabs, ribbon groups, and buttons into the order you want to display them. To move any of these, select the object you want to move and then click the Move Up and Move Down buttons (up-arrow and down-arrow buttons on the right side of the dialog). Figure 2 - 21 shows the new custom Definition ribbon tab with multiple ribbon groups. I created the Definition tab to help me to properly define each new project I create.
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Figure 2 - 21: New custom ribbon tab





Resetting the Ribbon


Microsoft Project allows you to reset the entire ribbon back to its default settings, or to reset any default ribbon tab to its default settings. To reset only a single ribbon tab, select the ribbon tab in the list on the right side of the dialog, click the Reset pick list button, and select the Reset only selected Ribbon tab item on the list. The software resets the selected ribbon tab immediately. To reset the entire ribbon, click the Reset pick list button and choose the Reset all customizations item on the list. The software displays the warning dialog shown in Figure 2 - 22. Click the Yes button to confirm the reset action.
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Figure 2 - 22: Warning dialog to reset all customizations to the Ribbon and Quick Access Toolbar





Warning: Notice in the dialog shown previously in Figure 2 - 22 that the software is about to reset all of the customizations to both the Ribbon and the Quick Access Toolbar. If you do not want to reset customizations to the Quick Access Toolbar, then do not select the Reset All Customizations option. Instead, reset each customized ribbon tab individually.


Hands On Exercise


Exercise 2 - 4


Customize the Ribbon by creating a new ribbon tab and adding a custom ribbon group and buttons to the new ribbon tab.


1.Return to the Project Navigation 2019.mpp sample file, if necessary.


2.Click the File tab and then click the Options button in the lower left corner of the Backstage.


3.In the Project Options dialog, click the Customize Ribbon tab.


4.In the Customize Ribbon section of the Project Options dialog, click the Choose commands from pick list and select the All Commands item on the list.


5.In the list of ribbon tabs on the right side of the dialog, scroll to the bottom of the list and select the last item on the list (it should be the Help ribbon tab).


6.In the lower right corner of the dialog, click the New Tab button.


Notice that Microsoft Project added a new ribbon tab named New Tab (Custom) along with a new ribbon group named New Group (Custom).


7.Select the New Tab (Custom) item and then click the Rename button.


8.In the Rename dialog, enter PM Life Cycle in the Display name field, and then click the OK button.


9.Select the New Group (Custom) item and then click the Rename button.


10.In the Rename dialog, enter Create New Project in the Display name field, and then click the OK button.


11.With the Create New Project (Custom) ribbon group still selected, individually select each of the following buttons in the Choose commands from list and then click the Add >> button to add them to the new ribbon group:


•New File


•New from Template


•Open


•Save


•Close File


12.In the new custom Create New Project group, select the New from Template item and then click the Rename button.


13.In the Rename dialog, enter New from Template in the Display name field, and then click the OK button.


14.Click the OK button to close the Project Options dialog.


15.Click the PM Life Cycle tab to display the new custom PM Life Cycle ribbon.


16.In the Create New Project section of the PM Life Cycle ribbon, click the New button.


Notice that Microsoft Project creates a new blank project.


17.In the Create New Project section of the PM Life Cycle ribbon, click the Close button to close the new blank project.


18.In the Create New Project section of the PM Life Cycle ribbon, click the New from Template button.


Notice that Microsoft Project displays the New page of the Backstage where you can create a new project from any available template.


19.Press the Escape key on your computer keyboard to exit the Backstage.


20.Leave the Project Navigation 2019.mpp sample file open for the next exercise.


Customizing the Quick Access Toolbar


As with the Ribbon, Microsoft Project also allows you to customize the Quick Access Toolbar. By default, the Quick Access Toolbar appears above the Ribbon, in the upper left corner of the application window. By default, the Quick Access Toolbar contains only three buttons: the Save, Undo, and Redo buttons. You use the Quick Access Toolbar to provide quick access to the buttons you use most often. For example, many users like to add the Open and Close buttons to the Quick Access Toolbar. Microsoft Project allows you to customize the Quick Access Toolbar in two ways:


•Add or remove buttons on the Quick Access Toolbar.


•Move the Quick Access Toolbar below the Ribbon.


To rapidly customize the Quick Access Toolbar, click the Customize Quick Access Toolbar button (pick list arrow button) at the far right end of the toolbar. The software displays a pick list menu of commonly used buttons, such as the New and Open buttons, as shown in Figure 2 - 23. Individually select any of the buttons shown on the pick list menu to add them to the Quick Access Toolbar. Keep in mind that when you use this method, Microsoft Project always adds the selected buttons to the right end of the Quick Access Toolbar.
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Figure 2 - 23: Customize Quick Access Toolbar menu





To display the Quick Access Toolbar below the Ribbon so that you can see all of the buttons easily, click the Customize Quick Access Toolbar button again and then select the Show Below the Ribbon item on the pick list menu. Alternately, you can also right-click anywhere in the Quick Access Toolbar and then select the Show Quick Access Toolbar Below the Ribbon item on the shortcut menu.


To take more control over the buttons you want to add and to control their location on the Quick Access Toolbar, click the File tab and then click the Options button in the lower left corner of the Backstage. In the Project Options dialog, click the Quick Access Toolbar tab, such as shown in Figure 2 - 24.
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Figure 2 - 24: Project Options dialog, Quick Access Toolbar page





Information: Microsoft Project offers you two additional methods for displaying the Project Options dialog with the Quick Access Toolbar tab selected. The first method is to right-click anywhere in the Quick Access Toolbar and to select the Customize Quick Access Toolbar item on the shortcut menu. The second method is to click the Customize Quick Access Toolbar button and then to click the More Commands item at the bottom of the menu.


The process of customizing the Quick Access Toolbar is very similar to the process of customizing the Ribbon. In the upper left corner of the dialog, click the Choose commands from pick list to choose the type of commands you want to add to the Quick Access Toolbar. The pick list offers you quite a number of choices, including Popular Commands (the default setting), Commands Not in the Ribbon, All Commands, and Macros, plus the commands found on every available ribbon tab.


In the upper right corner of the dialog, click the Customize Quick Access Toolbar pick list and choose how to customize the Quick Access Toolbar. The choices on the pick list allow you to customize the Quick Access Toolbar for all projects (the default option) or only for the active project. The second option means that you could theoretically have a different customized Quick Access Toolbar for each project you manage, based on your project management needs for each project.


After you select your options on the Choose commands from pick list and the Customize Quick Access Toolbar pick list, you are ready to customize the Quick Access Toolbar. The software offers you the following customization choices:


•Add/remove buttons and separators on the Quick Access Toolbar.


•Add a button for a macro and then modify the macro button.


•Change the display order of buttons on the Quick Access Toolbar.


•Reset the Quick Access Toolbar to its default settings.


•Import or export the customized ribbon and Quick Access Toolbar settings to a file.


Information: Microsoft Project also allows you to display the Quick Access Toolbar below the Ribbon by selecting the Show Quick Access Toolbar below the Ribbon checkbox in the lower left corner of the Quick Access Toolbar page of the Project Options dialog.


Adding/Removing Buttons on the Quick Access Toolbar


To add a button to the Quick Access Toolbar, select the button in the list of buttons on the left side of the dialog. In the list of buttons on the right side of the dialog, select a button in the location where you want to add the new button, and then click the Add >> button. The software adds the new button below the selected button. To add a separator to organize the buttons into groups, select the <Separator> item at the top of the list on the left and click the Add >> button. You place separators in the list of buttons to add gridlines between the buttons and to separate the buttons into groups in the Quick Access Toolbar.


Information: To quickly add any button to the Quick Access Toolbar, you do not need to use the Project Options dialog at all. Instead, right-click on any button in the Ribbon and then select the Add to Quick Access Toolbar item on the shortcut menu.


If you add a button for a macro to the Quick Access Toolbar, Microsoft Project activates the Modify button in the lower right corner of the Project Options dialog. Click the Modify button to change the name of the button and to change the icon displayed for the button in the Quick Access Toolbar. The software displays the Modify Button dialog shown in Figure 2 - 25.
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Figure 2 - 25: Modify Button dialog





To remove a button or separator on the Quick Access Toolbar, select the item in the list of buttons on the right side of the Project Options dialog, and then click the Remove button.


Moving Items in the Quick Access Toolbar


Microsoft Project allows you to move the buttons and separators on the Quick Access Toolbar into the order you want to display them. To move a button or a separator, select the item you want to move and then click the Move Up and Move Down buttons (up-arrow and down-arrow buttons on the right side of the Project Options dialog).


Figure 2 - 26 shows the custom setup of my Quick Access Toolbar. I included the buttons I most commonly use, and then I organized the buttons into groups of similar functionality using separators.


Information: If you create a customized Quick Access Toolbar for all documents and then create a different customized Quick Access Toolbar for a particular project, Microsoft Project combines the two toolbars together whenever you open that particular project. The combined Quick Access Toolbar includes the buttons for all projects in the left half of the toolbar, with the buttons from the individual project in the right half of the toolbar.
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Figure 2 - 26: Quick Access Toolbar section after customization





Resetting the Quick Access Toolbar


Microsoft Project allows you to reset only the Quick Access Toolbar to its default settings, or to reset both the Quick Access Toolbar and the Ribbon to their default settings. To reset only the Quick Access Toolbar, click the Reset pick list button in the lower right corner of the Project Options dialog, and then select the Reset only Quick Access Toolbar item on the list. The software displays the confirmation shown in Figure 2 - 27. Click the Yes button to reset the Quick Access Toolbar to its default settings.
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Figure 2 - 27: Confirmation dialog to reset only the Quick Access Toolbar





To reset both the Quick Access Toolbar and the Ribbon, click the Reset pick list button and select the Reset all customizations item on the list. The software displays the confirmation dialog shown in Figure 2 - 28. Click the Yes button to confirm the reset action.
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Figure 2 - 28: Confirmation dialog to reset the Ribbon and Quick Access Toolbar





Hands On Exercise


Exercise 2 - 5


Customize the Quick Access Toolbar by adding tracking buttons.


1.Return to the Project Navigation 2019.mpp sample file, if necessary.


2.Click the File tab and then click the Options button in the lower left corner of the Backstage.


3.In the Project Options dialog, click the Quick Access Toolbar tab.


4.In the Quick Access Toolbar page of the Project Options dialog, click the Choose commands from pick list and select the All Commands item on the list.


5.In the list of commands on the right side of the dialog, select the Redo command.


6.In the list of commands on the left side of the dialog, individually select each of the following commands and then click the Add >> button to add them to the Quick Access Toolbar:


•<Separator>


•0% Complete


•25% Complete


•50% Complete


•75% Complete


•100% Complete


•<Separator>


•View (select the second View item in the list of four View items)


•Switch Tables


•Filter


•Group By (use the command with the pick list on the right end of the command)


7.In the lower left corner of the Customize the Quick Access Toolbar page, select the Show Quick Access Toolbar below the Ribbon checkbox.


8.Click the OK button to close the Project Options dialog.


9.Examine the new buttons you just added to the Quick Access Toolbar.


10.Leave the Project Navigation 2019.mpp sample file open for the next exercise.


Importing/Exporting a Custom Ribbon and Quick Access Toolbar


Microsoft Project allows you to back up your Ribbon and Quick Access Toolbar customization settings by exporting them to a file. You can also give this file to other users who can import your customization settings into their own Microsoft Project application.


To export your Ribbon and Quick Access Toolbar settings to a file, click the Import/Export pick list button in the lower right corner of the Project Options dialog and then select the Export all customizations item on the pick list. The Project Options dialog includes the Import/Export pick list button on both the Customize Ribbon and Quick Access Toolbar pages, by the way. The software displays the File Save dialog shown in Figure 2 - 29. In the File Save dialog, enter a name for the customization file in the File name field, select a destination location for the file, and then click the Save button.
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Figure 2 - 29: File Save dialog





Information: Notice in in the File Save dialog shown in Figure 2 - 29 that *.exportedUI is the file extension for the exported customization file.


To import the Ribbon and Quick Access Toolbar customization settings from an existing export file, click the Import/Export pick list button and select the Import customization file item on the pick list. The software displays the File Open dialog shown in Figure 2 - 30. In the File Open dialog, navigate to the location of the customization file and select it, and then click the Open button.
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Figure 2 - 30: File Open dialog





The software displays the confirmation dialog shown in Figure 2 - 31. This dialog warns that the import process replaces all existing customizations to both the Ribbon and the Quick Access Toolbar. In the confirmation dialog, click the Yes button to import the customized Ribbon and Quick Access Toolbar settings, and replace your current settings. Click the OK button in the Project Options dialog to view your new customized Ribbon and Quick Access Toolbar.
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Figure 2 - 31: Confirmation dialog when importing customization settings





Hands On Exercise


Exercise 2 - 6


Export the Ribbon and Quick Access Toolbar customization settings to a file.


1.Return to the Project Navigation 2019.mpp sample file, if necessary.


2.Click the File tab and then click the Options button in the lower left corner of the Backstage.


3.In the Project Options dialog, click the Customize Ribbon tab.


4.In lower right corner of the Project Options dialog, click the Import/Export pick list button and select the Export all customizations item on the list.


5.In the File Save dialog, navigate to the folder where you unzipped the sample files that accompany this book.


6.In the File Save dialog, leave the default name Project Customizations.exportedUI in the File name field, and then click the Save button.


7.Click the OK button to close the Project Options dialog.


Exercise 2 - 7


Reset the customizations you made to the Ribbon and the Quick Access Toolbar.


1.Click the File tab and then click the Options button in the Backstage.


2.In the Project Options dialog, click the Customize Ribbon tab.


3.In lower right corner of the Project Options dialog, click the Reset pick list button and select the Reset all customizations item on the list.


4.When prompted in the confirmation dialog, click the Yes button to reset all customizations to the Ribbon and the Quick Access Toolbar back to their default settings.


5.Click the OK button to close the Project Options dialog.


Notice that Microsoft Project removed the new custom PM Life Cycle ribbon tab and removed all of the buttons you added to the Quick Access Toolbar.


Exercise 2 - 8


Import Ribbon and Quick Access Toolbar customization settings from a file.


Information: As a special gift to you, Projility developed a number of best practice customizations settings for the Ribbon and Quick Access Toolbar, and saved these settings to a customization file. After you complete this exercise, you will find your Microsoft Project user interface to be much more user friendly


1.Click the File tab and then click the Options button in the lower left corner of the Backstage.


2.In the Project Options dialog, click the Customize Ribbon tab.


3.In the lower right corner of the dialog, click the Import/Export pick list button and select the Import customization file item on the pick list.


4.In the File Open dialog, navigate to the folder where you unzipped the sample files that accompany this book.


5.In the File Open dialog, select the Projility MSP Ribbon and QAT Customizations.exportedUI sample file, and then click the Open button.


6.When prompted in the confirmation dialog, click the Yes button to replace all current customizations to the Ribbon and the Quick Access Toolbar.


7.Click the OK button to close the Project Options dialog.


8.Examine each of the commands added to the Quick Access Toolbar.


9.Click the Definition tab to display the new custom Definition ribbon.


10.Study the sections and commands in the Definition ribbon.


You can use the commands in the Definition ribbon to properly define every new project you start, whether you start the project from a blank file or from a template file.


11.Click the Report tab to display the Report ribbon.


12.In the View Reports section of the Report ribbon, click the Dashboards pick list button and select the Project Overview report.


13.In the lower left corner of the Project Overview report, click anywhere in the Milestones Due table.


14.Click the Design tab with the Table Tools applied.


Notice the Table Text Formatting section of the Design ribbon, and the buttons in this section, which were added to this ribbon when you imported from the customization file.


15.Leave the Project Navigation 2019.mpp sample file open for the next exercise.


Accessing and Using the Backstage


As noted earlier in this module, click the File tab to display the Backstage and access the most commonly used file commands, such as opening, saving, or printing a project file. If you click the File tab when you have no project currently open (or you have the default Project1 file open), the software displays the Backstage with the Open page selected, as shown in Figure 2 - 32. Notice that the Open page includes a Recent Projects section to show the list of files you recently opened.


Information: If you open any project and then click the File tab, the software displays the Backstage with the Home page selected instead of the Open page.
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Figure 2 - 32: Open page in the Backstage





The sidepane on the left side of the Backstage contains both tabs and buttons, which allow you to use the file features in Microsoft Project. In the Backstage, you can perform any of the following actions:


•Click the Home tab to display the Home page. Use this page to create a new project or open a recent project.


•Click the New tab to display the New page. Use this page to create a new project using several different methods.


•Click the Open tab to display the Open page. Use this page to open a recently used project or to browse to any folder and open other projects.


•Click the Info tab to display the Info page for the active project. Use this page to see and edit high-level in-formation about your active project, and to access to the Organizer dialog.


•Click the Save button to save the active project.


•Click the Save As tab to display the Save As page. Use this page to save the active project to a OneDrive or SharePoint folder, to synchronize the active project with a SharePoint Tasks list, or to browse to any folder and save the active project.


•Click the Print tab to display the Print page. Use this page to print the active project.


•Click the Share tab to display the Share page. Use this page to synchronize the active project with a Share-Point Tasks list or to e-mail a copy of the active project to a fellow user.


•Click the Export tab to display the Export page. Use this page to save the active project using an alternate file type, such as an XML file, or to save the active project as a PDF document.


•Click the Close button to close the active project.


•Click the Account tab to display the Account page. Use this page to change the Office Background and Office Theme settings, or to view the activation status of your copy of Microsoft Project.


•Click the Feedback tab to display the Feedback page. Use this page to send suggestions to Microsoft about changes you would like to see in Microsoft Project.


•Click the Options button to display the Project Options dialog.


Using the Info Page


To specify information about the active project, click the Info tab in the Backstage. Microsoft Project displays the Info page for the project, as shown in Figure 2 - 33. Notice the following about the Info page:


•The software displays the file path for the active project immediately below the file name at the top of the page.


•The software displays statistics and properties for the active project in the Project Information section on the right side of the page.


•The software allows you to create and manage login accounts for Project Online or Project Server 2019 in the Project Web App Accounts section of the page. This feature is only available in the Professional version of Microsoft Project.


•The software allows you to access the Organizer dialog in the Organize Global Template section of the page.




[image: image]


Figure 2 - 33: Info page for the selected project





Information: If you click the file path immediately below the file name at the top of the Info page, Microsoft Project displays a menu with two available options. If you select the Copy path to clipboard item, the software copies the file path to the Windows Clipboard. If you select the Open file location item, the software launches the Windows Explorer and navigates to the folder where the file resides.


When you click the Manage Accounts button, the software displays the Project Web App Accounts dialog. Because this feature is specifically for organizations that use Project Online or Project Server 2019 for enterprise project management, I do not discuss the features of this dialog.


When you click the Organizer button on the Info page of the Backstage, the software displays the Organizer dialog shown in Figure 2 - 34. You use the Organizer dialog to work with default and custom objects in Microsoft Project, such as views, tables, filters, groups, reports, and calendars.
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Figure 2 - 34: Organizer dialog





When you click the Project Information pick list in the upper right corner of the Info page, the software displays the pick list shown in Figure 2 - 35. On the pick list, select the Advanced Properties item to display the Properties dialog, in which you can enter custom properties for the selected project. Select the Project Statistics item to display the Project Statistics dialog to view high-level data about the project.
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Figure 2 - 35: Project Information pick list on the Info page





Click the Project Information pick list and select the Advanced Properties item to display the Properties dialog, such as the one shown in Figure 2 - 36. Use this dialog to enter high-level properties about the project, such as a Title for the project and Comments about the project.
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Figure 2 - 36: Properties dialog





Click the Project Information pick list and select the Project Statistics item on the list to display the Project Statistics dialog shown in Figure 2 - 37. Use this dialog to view the high-level data about the current schedule of the project, compared to the original baseline schedule of the project.
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Figure 2 - 37: Project Statistics dialog





Using the New Page


To create a new project, click the New tab in the Backstage. Microsoft Project displays the New page shown in Figure 2 - 38. Notice that the New page appears very similar to the Start screen shown previously in Figure 2 - 1. Notice that the New page includes the following types of templates for you to use to create a new project:


•Blank Project – Use this template to create a new blank project.


•New from existing project – Use this template to create a new project that is a copy of an existing project.


•New from Excel workbook – Use this template to create a new project from a Microsoft Excel workbook using the Import Wizard.


•New from SharePoint Tasks List – Use this template to create a new project from a Tasks list in a Share-Point site. Before you can use this feature, however, your SharePoint administrator must create a SharePoint site containing a Tasks list, and the Tasks list must contain a list of tasks you want to import as a new project.
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Figure 2 - 38: New page in the Backstage





In addition to the four types of templates listed previously, the New page also offers a selection of Microsoft Project templates available from the Office.com website. The New page displays these Office.com templates in the bottom half of the page. Microsoft allows you to download and use any of these templates free of charge. Notice that each Office.com template icon includes a preview picture of the project schedule created from that template type.


Information: To pin one of the Office.com templates so that Microsoft Project always displays the template at the top of the New page in the Backstage, float your mouse pointer over the template icon and then click the Pin to list button (the “pushpin” button) in the lower-right corner of the icon. To unpin a pinned template, float your mouse pointer over the pinned template icon and then click the Unpin from list button (the “pushpin” button) in the lower-right corner of the icon.


If the New page does not display the type of template you want to use to create a new project, you can use the search features in the middle of the page to locate an appropriate template in the Office.com website. To search for a project template, enter your search term in the Search for online templates field and then click the Start searching button at the right end of the field. Alternately, you can click one of the links in the Suggested searches line, such as the Business link, for example. During the search process, Microsoft Project briefly displays a Searching thousands of online templates message, and then reveals the search results on the New page, such as shown in Figure 2 - 39. Notice that my search for construction templates yielded two templates. After conducting a search for templates in the Office.com website, you can return to the unfiltered New page by clicking the [image: image] Back button to the left of the Search for online templates field.
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Figure 2 - 39: Search for construction templates in the Office.com web site





To create a new project from one of the Office.com templates, click the icon of the template you want to use. Microsoft Project displays a preview dialog for the selected template, similar to the one shown in Figure 2 - 40. Notice that the preview dialog shown displays a preview of the New Business Plan template, which includes a pre-built Timeline report at the top of the template. The preview dialog also includes additional information about the template, including the name of the template creator (in this case, Microsoft), a description of when and how to use the template, and the file size of the project created from the selected template.


To create a new project from the selected template, enter the start date of the project in the Start Date field and then click the Create button. Microsoft Project downloads a copy of the template and saves it in the default Templates folder on your computer’s hard drive, and then creates a new project from the selected template, ready for you to use to plan and manage your project.


Information: To navigate in the preview dialog to the previous template or the next template on the New page, click the Previous or Next buttons (big green arrow buttons) on the left and right sides of the preview dialog.
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Figure 2 - 40: New Business Plan template preview dialog





Information: For many years, one of the most popular Microsoft Project templates in the Office.com web site has been the Wedding planner template. To locate this template, type wedding planner in the Search for online templates field and then click the Start searching button at the right end of the field. If you want to use this template to plan your own wedding, remember that your future mother-in-law will be a stakeholder in the project!


Accessing Templates Stored in Your Templates Folder


Because of functionality that Microsoft introduced originally in Office 2013 many years ago, the New page in the Backstage does not automatically allow you to create a new project from any template stored in your default Templates folder. This includes templates that you download from the Office.com website and templates that you create personally and save in your Templates folder. If you want to create a new project from any template stored in your Templates folder, you must complete the following steps first:


1.Click the File tab and then click the Options button in the Backstage.


2.Click the Save tab in the Project Options dialog. The software displays the Save page of the Project Options dialog shown in Figure 2 - 41.


3.In the Default personal templates location field in the Save templates section of the dialog, manually enter the path for your default Templates folder based on the example below, or click the Browse button to navigate to your default Templates folder, such as shown below:


C:\Users\YourUserID\AppData\Roaming\Microsoft\Templates


4.Click the OK button.


Information: Microsoft Project does not require you to use the default Templates folder as the location where you save your personal project templates. In fact, the software allows you to use any folder of your choice. For example, you might use the Windows Explorer software to create your own custom templates folder named C:\Project Templates, and then designate this folder in step #3 above. You must manually create the project templates in this folder.
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Figure 2 - 41: Project Options dialog, Save page





Warning: If you want to use templates in your default Templates folder with any of your other Microsoft Office applications, you must repeat the same process detailed above in each of these applications individually. There is no way currently to specify the default Templates folder for all of the Microsoft Office applications simultaneously.


The next time you navigate to the New page in the Backstage, Microsoft Project displays two new links immediately above the Search for online templates field: the Office link and the Personal link. When selected, the Office link displays Office.com templates. Click the Personal link to view project templates stored in your default Templates folder, as shown in Figure 2 - 42. Notice that I have four templates available for use in my default Templates folder, all downloaded from the Office.com website.
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Figure 2 - 42: New page shows Personal templates





To create a new project from a personal template, click the Personal link on the New page of the Backstage and then click the icon for the template you want to use. Microsoft Project displays the dialog shown in Figure 2 - 43. Notice that the dialog does not contain a preview image of the template, nor does it provide any other information about the template. In this dialog, enter the project start date in the Start Date field and then click the Create button. The software creates the new project as a copy of the template you selected.


Information: To navigate in the preview dialog to the previous personal template or the next personal template, click the Previous or Next buttons (big green arrow buttons) on either the left side or the right side of the dialog.
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Figure 2 - 43: Preview dialog for a Market Research personal template





Hands On Exercise


Exercise 2 - 9


Explore the New and Info pages in the Backstage.


1.In your Quick Access Toolbar, click the Close button to close the Project Navigation 2019.mpp sample file.


2.If prompted in a confirmation dialog to save the changes to the sample, click the No button.


If Microsoft Project displays the New page in the Backstage, skip step #3 and continue with step #4. Otherwise, continue this exercise with step #3.


3.Click the File tab and then click the New tab in the Backstage.


4.In the Search for online templates field near the top of the New page, enter marketing in the field and then click the Start searching button (the magnifying glass icon).


5.Click the icon for the New Business Plan template.


Notice the relevant information about this template in the upper right corner of the preview dialog, including the creator of the template and recommendations on using the template.


6.In the Start Date field in the preview dialog, enter the date of the first Monday that is three months from the current month, and then click the Create button.


Hint: In the previous step, if today is October 15, 2020, this means you should enter January 4, 2021 in the Start Date field. This is because January 4, 2021 is the first Monday of the month that is three months later than October 2020.


7.Click the File tab and then click the Info tab in the Backstage.


In the Project Information section on the right side of the Info page, notice the relevant information about this project, including the current Start Date and Finish Date for the project.


8.Click the Project Information pick list and then click the Advanced Properties item on the pick list.


9.In the Properties dialog, enter Spin Off Creative Division in the Title field.


10.In the Properties dialog, enter your name in the Author and Manager fields, enter the name of your organization in the Company field, and then click the OK button.


11.Press the Escape key on your computer keyboard to exit the Backstage.


12.Double-click the right edge of the Task Name column to “best fit” the width of this column, then drag the split bar to the right edge of the Duration column.


Notice that Microsoft Project displays the Title information you entered in the Properties dialog as the task name of the Project Summary Task (Row 0 or Task 0).


13.In your Quick Access Toolbar, click the Save button to save the new project.


14.In the Save As page in the Backstage, click the Browse button.


15.In the Save As dialog, navigate to the folder where you unzipped the sample files that accompany this book.


16.In the Save As dialog, enter Spin Off Creative as New Company in the File name field, and then click the Save button.


17.In your Quick Access Toolbar, click the Close button close your new project.


Exercise 2 - 10


Customize Microsoft Project to give you access to your personal project templates.


1.If not already in the Backstage, click the File tab and then click the Options button in the Backstage.


2.In the Project Options dialog, click the Save tab.


3.In the Default personal templates location field in the Save templates section of the dialog, manually enter the path for your default Templates folder based on the example below, or click the Browse button to navigate to your default Templates folder.


C:\Users\YourUserID\AppData\Roaming\Microsoft\Templates


4.Click the OK button to close the Project Options dialog.


5.Click the File tab and then click the New tab in the Backstage.


Immediately above the Search for online templates field, notice the Office and Personal links. Notice also that the software selects the Office link by default, which shows you the templates available from the Office.com website.


6.Click the Personal link near the top of the New page.


Notice the icon for the New Business Plan template, from which you created a new project in Exercise 2 - 9. Remember that the Personal page only displays Office.com templates from which you created a new project, or new templates that you created and saved in your default Templates folder.


7.Click the button for the New Business Plan template.


Notice that the upper right corner of the preview dialog contains none of the relevant information about the template that you saw previously in the preview dialog you used in Exercise 2 - 9, such as the creator or the template or recommended best uses for the template. You only see information such as this in the preview dialog when you create a new project directly from an Office.com template.


8.Click the Close button (the X button) in the upper right corner of the preview dialog.


9.Press the Escape key on your computer keyboard to exit the Backstage.


Using the Save As Page


To save a new project, click the Save As tab in the Backstage. Microsoft Project displays the Save As page, such as the one shown in Figure 2 - 44. You can use the Save As page to save your project using a variety of methods, including each of the following:


•Saving the project file to your computer


•Saving the project file in a OneDrive folder in the cloud


•Saving the project file in a Documents library in SharePoint


•Synchronizing your project file with a SharePoint Tasks list
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Figure 2 - 44: Save As page in the Backstage





Saving a Project to your Computer


To save the current project file to a folder on your computer or on a network share, click the This PC link in the Recent section of the Save As page, if not already selected. The software displays a Save As page similar to the one shown previously in Figure 2 - 44. The right half of the Save As page shows the list of recently used folders in which you saved project files. Select one of the recently used folders or click the Browse button to display a Save As dialog similar to the one shown in Figure 2 - 45.


When you click the name of a folder, Microsoft Project navigates directly to the selected folder. If you click the Browse button, the software navigates to the Documents folder on your computer. In the Save As dialog, navigate to the folder where you want to save your project, enter a name for the project in the File name field, and then click the Save button.


By the way, the Save As dialog offers you a number of additional ways to navigate to a folder and to save a new or existing project, including each of the following:


•Click one of the folders shown in the “breadcrumb” bar at the top of the dialog.


•Click the Previous Locations pick list button at the right end of the “breadcrumb” bar and select a previous location from the list.


•Enter a search term in the Search field in the upper right corner of the dialog and then click the Search button at the right end of the field.


•Click the New Folder button at the top of the dialog to create a new folder.


•Click the Save as type pick list at the bottom of the dialog, and choose an alternate file type to save, such as an Excel Workbook file.


•Click the Tools pick list button at the bottom of the dialog and select the Map Network Drive item to map a network drive and assign it a drive letter.


•Click the Tools pick list button at the bottom of the dialog and select the General Options item to add password protection to the file or to automatically create a backup of the project file.


Information: After you save the project initially, you can click the Save button in the Backstage to save the latest changes to the project.
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Figure 2 - 45: Save As dialog





Saving a Project to a OneDrive Folder


OneDrive is a cloud-based file storage system. As of the writing of this book, Microsoft provides a free OneDrive for Business site to each Office 365 user in your organization with a minimum of 1 Tb of free storage per user.


At the top of the Save As page shown in Figure 2 - 46, notice that there is a section specific to my organization (Projility), and that this section includes a OneDrive icon. This is because of the default functionality of Office 365, which automatically displays a OneDrive icon on the Save As page and the Open page in the Backstage of every Office application.
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Figure 2 - 46: Click the OneDrive icon





To save your project in the Documents folder in your OneDrive site, click the OneDrive icon on the Save As page and then click the OneDrive folder on the right side of the page, such as shown previously in Figure 2 - 46. Microsoft Project displays the Save As dialog and navigates to the Documents folder in the OneDrive site, such as shown in Figure 2 - 47. In the Save As dialog, enter a name for the project in the File name field, and then click the Save button.




[image: image]


Figure 2 - 47: Save As dialog with OneDrive site





If you want to add a personal OneDrive site to the Save As and Open pages in the Backstage, click the Add a Place link on the Save As page, such as shown in Figure 2 - 48.
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Figure 2 - 48: Click the Add a Place link





In the Add a Place section of the page, click either the OneDrive icon or the OneDrive for Business icon. The OneDrive icon is for people whose Office 365 account is for personal use, while the OneDrive for Business icon is for people in an organization that uses an Office 365 Business plan. Microsoft Project displays an Add a service dialog similar to the one shown in Figure 2 - 49.
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Figure 2 - 49: Add a service dialog





If you clicked the OneDrive icon, enter your personal Microsoft e-mail address in the Email address field (such as an Outlook.com e-mail address). If you clicked the OneDrive for Business icon, enter your business e-mail address in the Email address field. Click the Next button to continue the connection process. The software displays the Enter password dialog for your user account, such as the one shown in Figure 2 - 50.
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Figure 2 - 50: Enter password dialog





In the Enter password dialog, enter the password for your user account in the Password field, and then click the Sign in button. Microsoft Project connects to your personal OneDrive site and displays a OneDrive icon at the top of the Open and Save As pages in the Backstage. Follow the previous set of steps to save a project file in the Documents library of your personal OneDrive site.


Information: When you connect your copy of Microsoft Project to your personal OneDrive site, the system automatically connects all of the other applications in the Microsoft Office family to the OneDrive site as well, including Microsoft Word, Excel, and PowerPoint.


Saving a Project to SharePoint Documents Library


You can also save your Microsoft Project files in a Documents library in your organization’s default SharePoint site. At the top of the Save As page shown in Figure 2 - 51, notice that there is a section specific to my organization (Projility), and that this section includes a Sites icon for SharePoint. This is because of the default functionality of Office 365, which automatically displays a Sites icon for SharePoint on the Save As page and the Open page in the Backstage of every Office application.
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Figure 2 - 51: Click the Sites icon for SharePoint





To save your project in a Documents library in your organization’s default SharePoint site, click the Sites icon on the Save As page and then click the folder on the right side of the page, such as shown previously in Figure 2 - 51. Microsoft Project displays the Save As dialog and navigates to the SharePoint site, such as shown in Figure 2 - 52. Notice that the Save As dialog displays a Document Libraries list. In the Save As dialog, double-click the name of the Document Library in which you want to save the project, enter a name for the project in the File name field, and then click the Save button.
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Figure 2 - 52: Save As dialog for a SharePoint site





Synchronizing with a SharePoint Tasks List


The final option on the Save As page allows you to synchronize your project with a Tasks list in SharePoint. Please be aware that Microsoft introduced this feature in Microsoft Project 2013 and that the functionality of this feature provides only minimal synchronization capabilities between your project in Microsoft Project and the project data shown in the Tasks list in SharePoint.


To synchronize a project with a Tasks list in SharePoint, click the Sync with SharePoint icon on the Save As page of the Backstage, such as shown in Figure 2 - 53. Microsoft Project displays a special Sync with SharePoint Tasks List section on the right side of the page.
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Figure 2 - 53: Click the Sync with SharePoint icon





In the Sync with SharePoint Tasks List section on the right side of the page, the software offers you two methods for synchronizing your project file with a Tasks list in SharePoint:


•Synchronize with a new SharePoint site


•Synchronize with an existing SharePoint site


Synchronizing with a New SharePoint Site


To synchronize your project with a Tasks list in a new SharePoint site, leave the default New SharePoint site option selected in the Sync with field. Enter the name of the project in the Project name field. Optionally edit the address in the Site address field, if needed. Figure 2 - 54 shows completed information entered in the Sync with SharePoint Tasks List section. Click the Save button to create the new SharePoint site, to save your project file in the SharePoint site, and to synchronize your project with the Tasks list in SharePoint.
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Figure 2 - 54: Completed information in the Sync with SharePoint Tasks List section





Microsoft Project displays a series of status dialogs that show the status of the synchronization process, such as the one shown in Figure 2 - 55. If the project contains resources that are not part of the SharePoint site, the software displays a warning dialog like the one shown in Figure 2 - 56.
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Figure 2 - 55: Synchronization status dialog
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Figure 2 - 56: Resource warning dialog





When the synchronization process completes, Microsoft Project launches your web browser and navigates to the SharePoint site created during the synchronization process. Figure 2 - 57 shows the Home page of the SharePoint site created using the project in this example. If you click the Tasks link in the Quick Launch menu on the left side of the page, SharePoint displays the Tasks page with the Tasks list synchronized with the tasks in your project, such as shown in Figure 2 - 58.
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Figure 2 - 57: Home page of the Project site
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Figure 2 - 58: Tasks list from the project file





Information: SharePoint saves the actual Microsoft Project file on the Site Assets page. To access this page, click the Site Contents link in the Quick Launch menu, and then click the Site Assets icon on the Site Contents page.


Warning: You can only use this option if you have permissions in SharePoint to create a new SharePoint site. If you lack the required permissions in SharePoint, Microsoft Project displays an error message after you click the Save button. In a situation such as this, you should ask your SharePoint administrator to create a SharePoint site for you, and then you should use the second option, which is synchronizing with an existing SharePoint site.


Synchronizing with an Existing SharePoint Site


To synchronize your project with an existing SharePoint site, click the Sync with pick list and select the Existing SharePoint Site item. Edit the address in the Site address field, as needed, and then click the Verify Site button to confirm you entered the correct address. If the site verification process is successful, Microsoft Project activates the Tasks List field. Click the Tasks List pick list and select a Tasks list other than the default, if needed. Figure 2 - 59 shows the completed information entered in the Sync with SharePoint Tasks List section of the Save As page.




[image: image]


Figure 2 - 59: Completed information in the Sync with SharePoint Tasks List section





Click the Save button to begin the synchronization process. Microsoft Project displays a series of status dialogs that show the status of the synchronization process, such as the one shown previously in Figure 2 - 55. If the project contains resources that are not part of the SharePoint site, the software displays a warning dialog like the one shown previously in Figure 2 - 56.


When you synchronize with an existing SharePoint site, Microsoft Project does not launch your web browser. If you want to confirm that the synchronization process was successful, launch your web browser and navigate to the SharePoint site. The Home page of the SharePoint site should appear similar to the one shown previously in Figure 2 - 57. In the Quick Launch menu, click the Tasks link to view the synchronized Tasks list from your Microsoft Project schedule.


Hands On Exercise


Exercise 2 - 11


Save a project file to your computer.


1.Click the File tab and then click the New tab in the Backstage.


2.In the list of templates from Office.com shown in the bottom half of the page, click the icon for the Software Development Plan template.


3.In the preview dialog, enter a date that is approximately 6 months in the future in the Start Date field, and then click the Create button.


4.Click the File tab and then click the Save As tab in the Backstage.


5.On the Save As page in the Backstage, click the Browse button.


6.In the Save As dialog, navigate to the folder where you unzipped the sample files that accompany this book.


7.In the Save As dialog, manually enter Cocoa Beach Mobile App in the File name field, and then click the Save button.


8.Click the File tab and click the Save As tab again.


In list of recent folders on the right side of the Save As page, notice the name of the folder where you unzipped the sample files that accompany this book.


9.Press the Escape key on your computer keyboard to exit the Backstage.


10.Leave the Cocoa Beach Mobile App.mpp project open for the next exercise.


Exercise 2 - 12


Save a project file to a cloud-based file storage location.


Warning: To complete this Hands On Exercise, you must have an Office 365 user account that gives you access to either a OneDrive site or a OneDrive for Business site.


1.With the Cocoa Beach Mobile App.mpp project file still open, click the File tab and then click the Save As tab in the Backstage.


2.On the Save As page in the Backstage, click the OneDrive icon at the top of the page, and then click the OneDrive folder on the right side of the page.


3.In the Save As dialog, enter Madeira Beach Mobile App in the File name field and then click the Save button.


4.Click the Close button on your customized Quick Access Toolbar to close the project file.


Using the Open Page


To open an existing project, click the File tab and then click the Open tab in the Backstage. Microsoft Project displays the Open page in the Backstage, similar to the one shown in Figure 2 - 60. Notice that the Open page in my copy of Microsoft Project includes links for OneDrive and Sites at the top of the page, such as shown previously on the Save As page, as well as a list of recently opened projects on the right side of the page.
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Figure 2 - 60: Open page in the Backstage





To open a recently used project, click the name of the project in list of recently opened projects. Microsoft Project automatically opens the project in Read/Write mode, regardless of where you saved the project. To pin any recently opened project to the top of the recent projects list, float your mouse pointer over the file, and then click the Pin this document to the Recent Projects list button (the “pushpin” button) at the right end of the file name. Microsoft Project moves the project to the top of the list of recent projects, where it will remain until you unpin it. To unpin a pinned document, float your mouse pointer over the file, and then click the Unpin this document from the Recent Projects list button (the “pushpin” button) at the right end of the file name.


To open a file from your computer, click the This PC link in the Open page. The software updates the Open page as shown in Figure 2 - 61 with a list of recently used folders on the right side of the page. To navigate directly to your Documents folder, click the Documents link at the top of the page. To search for a file in a folder that contains many projects, click the name of a recently used folder, enter your keywords in the Search for files in this folder field. Microsoft Project searches the folder and reveals the names of matching projects in a pick list from which you can click the project name.
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Figure 2 - 61: Open a file from your computer





To open a file from your computer, you can also click the Browse button. Microsoft Project displays the Open dialog, such as the one shown in Figure 2 - 62. Navigate to the folder containing the project you want to open, click the name of the project to select it, and then click the Open button.


Information: To open the project in Read-Only mode, select the project to open, then click the pick list arrow button at the right end of the Open button. On the pick list, select the Open Read-Only item on the pick list.
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Figure 2 - 62: Open dialog





By the way, the Open dialog offers you a number of ways to locate and open an existing project, including each of the following:


•Click one of the folders shown in the “breadcrumb” bar at the top of the dialog.


•Click the Previous Locations pick list button at the right end of the “breadcrumb” bar.


•Enter a search term in the Search field in the upper right corner of the dialog.


•Click the Type pick list in the lower right corner of the dialog, and choose an alternate file type to open, such as an Excel Workbook file.


•Click the pick list button on the right edge of the Open button and select whether you want to open the selected file Read/Write or Read-Only mode, or to open a copy of the selected file.


•Click the Tools pick list button at the bottom of the dialog and select the Map Network Drive option to map a network drive and assign it a drive letter.


To open a project from a OneDrive site, click the OneDrive link at the top of the Open page. On the right side of the page, click the name of the project you want to open.


To open a project from a Documents library in a SharePoint site, click the Sites link at the top of the Open page. In the list of folders on the right side of the page, click the folder containing the project. Microsoft Project displays an Open dialog similar to the one shown in Figure 2 - 63. Click the name of the project to select it and then click the Open button. Microsoft Project opens the project and then immediately synchronizes the project with its Tasks list in the SharePoint site.
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Figure 2 - 63: Open dialog for a SharePoint site





Using the Print Page


To print the active project, click the Print tab in the Backstage. The software displays the Print page shown in Figure 2 - 64. Using the Print page, you can control any of the following printing options:


•Specify the number of copies to print in the Copies field.


•Select an available printer in the Printer pick list.


•View the printer status in a tool tip by floating your mouse pointer over the Printer Status icon in the Printer section of the page.


•Set printer options by clicking the Printer Properties link.


•Specify the date range for printing project information by clicking the Settings pick list and choosing a pre-defined or custom date range.


•Manually enter a date range in the Dates fields.


•Specify the page range to print by selecting a value in the Pages fields.


•Specify the orientation of the printout on the Print Orientation pick list.


•Specify the paper size on the Paper Size pick list.


•Display the Page Setup dialog by clicking the Page Setup link.


•View the print preview of the project in the right side of the page.


•Zoom in to the print preview to see more details by clicking anywhere in the print preview.


•Scroll through the pages in the print preview pane using the navigation buttons in the lower right corner of the page.


When you finish setting up your printing options, click the Print button to print the project file to the specified printer using your specified options.
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Figure 2 - 64: Print page in the Backstage





Using the Page Setup Dialog


When you click the Page Setup link, Microsoft Project displays the Page Setup dialog shown in Figure 2 - 65. This dialog includes tabs for six pages, including the Page, Margins, Header, Footer, Legend, and View pages. Use the options on the Page dialog to adjust the orientation and scaling of each printed page.


Click the Margins tab to displays the Margins page of the dialog. Use the options on the Margins page to adjust the margins and to display a border around each printed page.
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Figure 2 - 65: Page Setup dialog





Click the Header tab to display the Header page, or click the Footer page to display the Footer page of the Page Setup dialog. Figure 2 - 66 shows the Header page of the dialog. The Header page offers settings that allow you to display header information in the left, center, or right side of the header. The Footer page offers similar settings. By default, Microsoft Project selects the Center tab, allowing you to display project information in the center of the header on each printed page. Click the Left or Right tabs to display project information on the left side or right side of the header on each printed page. Use these same options on the Footer page of the dialog.
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Figure 2 - 66: Page Setup dialog – Header page





Microsoft Project offers you a number of methods for creating a header or a footer. To begin the process of creating a header or footer, first click the Left, Center, or Right tab to display the text area for the selected tab. After selecting the text area, use any of the following methods to create your header or footer:
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